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2 Hardware setup 

  
Please refer to YourDyno Data Acquisition system Installation and capabilities manual 
on how to install the YourDyno hardware. 

3 Software installation 

 
To install the YourDyno software please download the latest installation package 
from www.yourdyno.com website. 

1. After downloading the installation package please execute the file 
"YourDynoinstaller_x.x.xx.exe". 

NOTE: x.x.xx stands for version number. 

Press the button "Next" to start the installation wizard. 

 

 

2. Please select the preferred plugins from the list. Do not install plugins you will not 
use, as they may consume CPU and memory resources.  
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Press button "Next" to continue. 

 

3. Select installation directory or keep default location. 
Press button "Next" to continue. 



YourDyno Instrument kit 
Software user manual 

YourDyno.com 
Fonneland Engineering AS, 2021 

 

 

4. Press the "install" button to start installation. 
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5. After the installer has completed the job please press button "Finish" to close the 
wizard. 

 

4 What is the YourDyno software 
YourDyno is a highly customizable dynamometer control, data acquisition and data 
analysis software. The YourDyno Software allows users to perform manual or half-
automated test and measure various parameters of vehicles and engines. Additionally, 
to standard features the YourDyno Software offers ability to expand functionality using 
the built-in plugin system. 

 
The YourDyno Software is under constant development and many new features are 
regularly being added. Please periodically review this manual and check for updates. 

5 Main window 
5.1 Overview 
The main window consists of four main sections: 
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1. Top menu bar: 

 

 

2. Graph area: 

 

 

3. List of recorded test Runs: 
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4. Status bar: 

 

6 Menu: File 
The following functions are available in this menu: 

Clear all runs - this function will remove all test runs from the Runs List below the 
graph area. 
Open runs - open previously recorded test. 
Save runs - save file with recorded test runs. 
Print page setup - opens dialog window with settings for graph print-out. 
Print... - opens printer dialog. 
Exit - close the software. 

6.1 Print page setup 
This function opens following setup window: 
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Use this window to adjust your print-out page. 

6.1.1 Customizing print-out header. Company logo 
1. To upload your logo please activate the check-box "Enable header image". 
2. Click on "Set header image" and use the following dialog window to navigate and 

upload your image file with logo. 
3. Use the "Swap text and image location" button to position the logo either on left or 

right side of the page. 
4. Adjust the "Header print height (mm)" to your liking. The higher the header the 

more room for text and logo. 
5. You may use the multi-line text box to enter your company name and contact 

details. 
6. Click and move left or right the vertical divider to adjust the width of the text box 

and logo area. 
7. To change page orientation (Portrait or Landscape) and adjust margins please press 

"Page setup..." button. 
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8. Use "Print preview" button to verify the settings. 
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7 Menu: Run 
7.1 New/Load Session 
Use this function to start a new testing session. A session may contain multiple test 
runs. You typically use a separate session for every new car or engine.  

 
A Session stores information about gear ratio, brake setup and auto start-stop settings 
for a set of test Runs. Please create a new directory for each session (Directory name = 
Session name). All test Runs recorded within one Session are stored in single .csv file 
on your hard drive under the directory you created. The raw .log files are also stored in 
the Session folder. 

To start a new session / load existing one please open this window: 
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Press the "New/Load Session" button to set the directory where you want to save your 
file containing test Runs. You can create a sub-folder structure to organize your 
customers database, for example: 

 

 
New Runs will be added to any existing Runs already open in main window. Whenever 
a new Run is started the software offers the option to use previously recorded 
Retardation data (friction losses) or record new Retardation data. It is recommended to 
record new Retardation data as long as the conditions are not stable (oil and tires 
heating up). When using stored Retardation data, the retardation phase can be 
shortened, since the brake can be on.  
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7.2 New Run 
Use this function to record a new test Run using the current Session. This function will 
directly open the Run (gauges) window where you must manually check all relevant 
settings prior to recording the Run. The recorded Run will be added to the list of Runs. 

8 Menu: Options 
8.1 Basic dyno Setup 
This function opens the main software settings window. 
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8.2 Brake Dyno w/Load Cell(s) 
If your dynamometer is equipped with brakes (any type) activate the "This is a Brake 
Dyno with...." checkbox. Adjust the count of load cells in use using up and down arrows 
(1, 2 or 4 load cells). This value also defines the number of brakes in use. 
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8.2.1 Inertia compensation 
Use this section to setup the inertia of the dynamometer and all rotating components 
of the drive train. To enable the inertia losses compensation (typical on roller 
dynamometers) please activate the checkbox "Compensate for inertia effects during 
acceleration". Then enter correct value in the "Moment of Inertia..." filed in correct unit 
(kgm²). 

The inertia value needs to be entered under each load cell tab. The effective inertia is 
typically the same for each brake but does not need to be in case different brakes and 
or rollers are used on front and rear.  

 

8.2.2 Load Cell calibration 
Use this section to calibrate the load cells. 

 

Torque arm length is the distance between the brake axis and the point where the 
torque arm is touching the load cell: 



YourDyno Instrument kit 
Software user manual 

YourDyno.com 
Fonneland Engineering AS, 2021 

 

 

Calibration weight is the load you use to calibrate the load cell. The more accurate the 
values the more precise the wheel torque measurement will be. Aim for a calibration 
weight of minimum 20% of the max rating of the load cell for accurate calibration.  

8.2.2.1 Load Cell calibration procedure 
1. Make sure that the load cell is correctly installed in the dynamometer and that 

nothing obstructs the sensor nor there are any parts laying on the Torque arm. 
2. Press "Zero calibrate!" button to set Load Cell zero. 
3. Install the Calibration Weight as per dynamometer user manual. 
4. Press "Load calibrate!". You can now remove the calibration tool. 
5. Press "Save calibration" 
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The calibration weight can be placed above the load cell, or further away from the 
brake axle. If placed further away, enter effective weight on the load cell, taking the 
arm length into consideration and the weight of the arm. This can be a good method 
when calibrating large load cells because it requires lower calibration weights. 

8.2.2.2 Calibration direction 
Use this setting to invert the calibration of the load cell. 
This is useful when you would like to run the dynamometer in opposite driving 
direction. 

 

 
Not all load cells are perfectly bi-directional and have exactly same calibration factors 
in both compression- and tension- directions. To assure highest possible measurement 
precision you should perform a "negative" calibration (use negative "Calibration 
weight" value). 

8.2.3 Information 
This section shows the current Load Cell reading and Raw data input. 

 

8.3 Inertia Dyno 
This section allows you to setup the Rotational Inertia for inertia-only dynos. 

To use the inertia-only dyno type please activate the checkbox "This is an Inertia Dyno" 
and enter the correct Mass Moment of Inertia in the field below.: 
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8.4 Engine power calculation 

 
A roller dynamometer is measuring power and torque at wheels. This is true for all 
roller dynos. There is no physical possibility to measure actual Clutch or Crank power 
on roller dynamometers. 

To be able to estimate the engine power, friction losses of the drivetrain must be 
measured during so called coast-down phase. To enable friction losses measurement 
please activate the "Enable correction for rolling resistance vs. speed from measured 
retardation data" checkbox.: 

 

 
Please note that the power losses in the drivetrain cannot be measured during coast-
down phase. The coast-down phase can measure solely coasting friction losses! 

Measuring friction losses gives a good estimation of Clutch (or Crank) power, but it is 
still burdened with a measurement error since the drive train will have higher losses at 
full power compared with at coast down. A roller dynamometer can therefore only 
measure parts of the losses, the total losses will be higher than the measured 
retardation losses. To accurately determine these losses, it is necessary to compare 
power readings between engine and roller dynamometer. 

To enable power-train losses correction, modify the "Power related losses" value: 
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8.5 OBD2 setup 
The YourDyno YOURDYNO Software offers a built-in interface that supports OBD2 
protocols using ELM327 adapter. This built-in system can be used with USB and 
Bluetooth OBD2 interfaces. 

 
Please use the "Scan Tool" plugin instead of the built-in OBD2 solution. 
See: "Plugins" in this manual. 

8.6 Noise filtering 
To modify the Noise filtering settings, adjust the three fields to desired level. 

We strongly advise to use lowest possible settings that allow good results and graph 
smoothing. 

 
Too smooth graphs will obstruct the ability to find faults in engine operation. 
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8.7 Raw data logging 
This feature enables raw data logging capability of the YourDyno Software. It can be 
used to troubleshoot and adjust dynamometer settings after a recorded test Run. To 
use this feature please enable checkbox "Enable raw data logging". 

 

8.8 Environmental power correction 
To enable power correction calculation based on environmental conditions please 
select the correction of choice. YourDyno supports:  

 SAE J1394-2004 
 DIN 70020 
 ISO 1585-2020 
 JIS D1001 
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 User defined 
You can choose between the built-in weather station of the YourDyno controller, use 
external sensor (Dracal PTH200) or enter the values manually. 

 
To use the PTH200 external environmental sensor please install the corresponding 
plugin first. 

 

8.9 Thermocouple 
The YourDyno controller offers one Thermocouple Type-K input. To activate it please 
enable "Thermocouple attached" checkbox. Select the Sensor Name from the 
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"Measurement" drop-down list in "Thermocouple setup" section or use <custom> and 
rename it to your liking. 

 

8.10  Aux channels 
The YourDyno controller offers three analog input channels (Aux 1 ... Aux 3). 

 
All Aux channels can accept max. 5V DC. Connecting higher voltage to any of these 
inputs will damage the electronic circuit board and void warranty! 

To activate each channel, enable the checkbox "Aux ... sensor connected). You can 
configure each channel separately and specify the analog input interpolation curve 
(relationship between input voltage and sensor reading). Sensor type and Unit are free 
text, and anything can be written here.  
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8.11  Brake controller setup 
To use automatic brake control, enable the checkbox in section "Auto brake setup": 

 

The default setting for Analog out Setup is: 
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You may use the "Test your brake" slider to manually set the brake output control 
signal and verify retarder operation. When powered up the Retarder is making 
characteristic "whining" noise. 

 
Please note that his procedure will directly apply the output voltage regardless of 
current condition of your dynamometer.  

WARNING: Potentially lethal voltages! 

8.12  Unit selection 
You can choose between different units in this section: 

 

8.13  Company logo 
You may choose to setup your company name or any other text to be displayed above 
Graph Area. 

This text will also be visible on print-out. 
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8.14  Define hotkeys 
Use this section to define hotkeys on a keyboard. 
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A wireless keyboard or wireless “clicker” such as the Logitech R400 is recommended, 
and its buttons can be configured with hotkeys. 

8.15  Result vs ??? 
The YourDyno Software is a powerful data analysis tool that allows users to quickly and 
efficiently tune their engines. One of the most important features is the ability to plot 
any recorded value in function of any other value. For example, it is possible to plot 
boost pressure, lambda, ignition timing (or any other channel) as function of Engine 
Torque (or any other channel). 
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To enable this feature please select desired channel from the drop-down list: 

 

8.15.1  Example: Engine RPM and Lambda vs Engine Torque 

 

8.16  Firmware upgrade 
This section allows you to perform Firmware update of the YourDyno controller. 
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Whenever “Update firmware” is shown in the status bar at bottom left, you must 
update the firmware. The firmware update system includes a failsafe mode such that it 
will revert to the previous firmware if an update was unsuccessful. There is also a 
second failsafe option; a button inside the box that can be pushed to force the unit into 
bootloader mode such that it is ready for firmware download in case a firmware 
upgrade failed.  

8.17  Language 
To change the interface language please select it from the menu list. 

The YourDyno Software will restart automatically. 

 

8.18  Restore and Backup options 

 
All settings in the YourDyno software are stored in an internal configuration file. You 
can “Backup the options to file” and use "Restore options from file" function to load the 
configuration file. 
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9 Menu: Plugins 
9.1 Mange plugins... 
This window allows users to add or delete plugins. 

 

 
All plugins are complied .dll files and stored in: C:\ProgramData\YourDynoPlugins 

9.2 Installing new plugin 
Installing official YourDyno plugins are done during installation of YourDyno. Do not 
download .dlls and install manually, since they are version dependent.  

To install 3rd party plugins please press the "Install plugin..." button in "Install new 
plugin" section. Then navigate to folder where your .dll file is saved. Select the file to 
install and press "Open" 

Your Plugin is now installed and ready to use. 
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9.3 Removing plugins 
To remove any plugin, the associated .dll file must be manually deleted from the 
C:\ProgramData\YourDynoPlugins folder. Exit the YourDyno software first: 

 

9.4 Scan Tool (OBDII plugin) 

 
To use the Scan Tool plugin make sure that the built-in OBD functionality is deactivated 
(see: Menu: Options -> OBD2 setup) 

An ELM327 Bluetooth or USB OBD2 adapter can be used. First install the software if 
any that accompany the adapter. If the ELM327 adapter is Bluetooth based, then 
connect to it first. Verify that you can see the adapter in the Device Manager. They 
appear as COM ports.  

Open YourDyno Software and navigate to Plugins -> Scan Tool. In the Connection tab 
please select which COM Port is in use, select Baud Rate (use 9600) and Connection 
type (OBD2 ELM) and press Connect. It may take up to one minute to connect to car's 
OBD interface. 
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9.4.1 Logging OBD parameters during test run 
1. Please navigate to "Live Data" tab in Scan Tool Plugin and select which channels you 
wan't to record (double-click) 

2. Activate checkbox "Log to gauges" 

3. Press "Start Logging" button. You may now close the Scan Tool plugin window. 

4. In Run window you may now add new gauges with respective OBD channels. 

 
Please note that the data logging from OBD-Adapter will work only with YourDyno 
hardware connected to PC. 



YourDyno Instrument kit 
Software user manual 

YourDyno.com 
Fonneland Engineering AS, 2021 

 

 

9.5 Speed and distance 
This plugin is adding new data channels: driving speed and driving distance. This is 
installed by default. 

To use the speed and distance channels setup the roller circumference (i.e. diameter in 
meters * 3.14).  

9.6 More plugin information 
Information on how to create your own plugins can be found here:  
https://yourdyno.com/plugin-system/ 

10 Graph area. Data analysis. Test Run list. 
10.1 Multi-graph view 
The Graph area can be divided into max. three sections. The main section is the Engine 
Power and Engine Torque diagram. 

To add and remove channels to the graph areas, press the ‘v’ button or right-click and 
select “Select visible graphs”. To split the graph area, add new channels into view.: 
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After adding additional channels like Lambda the Graph area is split horizontally: 
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To relocate the channels between graphs use "Drag-and-Drop" technique. LFB on the 
label and drag it over to another graph/axis. 

You can adjust the size and position of the horizontal and vertical dividers by dragging 
them with mouse cursor.: 

 

10.2 Manipulating the graph area. Context menu. 
LMB - LEFT mouse button 
MMB - MIDDLE mouse button 
RMB - RIGHT mouse button 

1.  
Quick reference guide: 
1. To move/drag the graph use MMB. 

2. Press and hold LMB to drag an Zoom-Area rectangle. 
3. Press RMB to open context menu. 
4. Use mouse wheel to Zoom In and Out. 

10.3 Context menu 
Un-Zoom / Undo All Zoom/Pan - use this function to reposition the graph back to 
normal view. 
Set Scale to Default - changes the channel scale back to standard value 
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Synchronize Y1 and Y2 axes - synchronizes Y-axis for all channels in the selected 
graph 
Increase / Decrease line thickness - use this function to change graph thickness. The 
changes is applied only in the section where the RMB menu was activated 

Edit graph - Use Ctrl key and LMB to select which graph area you want to cut. This 
change cannot be undone thus it is strongly advisable to make a copy of the file prior 
modification. Use Esc key to cancel. 

The software will lineally interpolate the graph if you remove a center portion of it. 

10.4 Results vs RPM 
This is the most typical use scenario for Power Test runs. In this view all channels are 
plotted against the Engine RPM channel. Use this view to print dyno sheets for 
customers. 

 
When Retardation Data is used the frictional losses are accounted and clutch power is 
shown. See: Options -> Engine power calculation 

 

10.5 Results vs Time 
Time is the only absolute Physical Size. It cannot be modified, slowed down, stopped. 

All channels in every Run are recorded in Time function. 

This view is very useful to analyze any variations in recorded channels during the test, 
regardless of Engine RPM changes. 
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10.6 Results vs ??? 
Depending on the selected channel in the Options -> Result vs ??? all recorded data will 
be plotted against any other selected value. This view is very useful to find best 
possible calibration of the tuned engine (for example when using Engine Torque as 
function): 

 

10.7 Test Run List 
Below the Graph Area you'll find list of Runs. 
You may change the Name and comments by clicking and editing the respective field. 
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Different columns shown/hidden by right-clicking:  

 

Rows can be sorted by clicking on the header. 

11 Results Table 
The Data Table allows users to analyze the recorded data in spread-sheet form: 

You can sort and manipulate the data in many ways. Please check RMB context menu 
for available options. 
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12 Run window 
12.1  Overview 
The Run window consist - like main window - of three main areas: 

1. Test name and comments section 

 

Use these fields to set Name for the Run and add Comments if necessary. 

On the right side of the Comments field current you will also see the current 
"Horsepower correction factor" and type of Session (either with or without Friction 
Losses / Retardation data measurement) 
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2. Gauges 
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3. Controls: 

 

12.2  Configuring Gauges 
12.2.1  Adding new gauges 
The gauges can be arranged to suit any style of work. 
You can add any recorded channel as gauge by pressing the "V" key on Keyboard or 
"Gauge on/off" button in the Controls area: 

 

A new window will pop-up with list of available channel. To avoid the problem of 
"hidden" gauges please use the "Auto arrange gauges" checkbox. 
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12.2.2  Types of gauges 
Analog 

This is a typical "tacho" style gauge with definable Green, Yellow and Red area. 
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Use the "Gauge setup" function in context menu to setup the colors: 

 

Digital 

This is a standard "number" style gauge with an horizontal bar below the value 
showing the range of the gauge. 

 

The colors for the horizontal bar are defined with the "Gauge setup" function as well. 

Live graph 

This type of gauge is a live-time graph with automatically adjusted X-axis. No color-code 
can be set for this type of graph. 
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Graph type gauges can use any channel as X-axis. This can be especially useful in 
steady state tuning, where you can get an instant Torque vs Lambda view or Torque vs 
Ignition angle view for example (assuming of course you have an Ignition angle channel 
from for example a CAN bus channel).  
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12.2.3  Example on one of possible gauges setup 

 

12.3  RPM setup. Gear ratio. Drive mode 
12.3.1  RPM setup 
This is the main settings function for the two RPM 1 and RPM 2 input channels. 

When selecting Load Cell 1 RPM as function for RPM1 input you will activate the Out1 
output signal and operate the respective Brake. This applies accordingly to the Load 
Cell 2 RPM function. 

 
The RPM1 and RPM2 input function setup is also determining which Brakes are in use! 
Take great care when setting these functions. 
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12.3.1.1 RPM 1 and RPM 2 input function setup 

 

RPM1 and RPM2 can be configured as:  

 1 Load cell RPM (RPM1 must be used for Load cell1 and Out1 and vice versa) 
 Load cell 1 and Load cell 2 using one RPM sensor. This case is used when two 

brakes are interlinked so the RPM is the same.  
 Engine RPM 
 

  
Ensure to write the correct number of pulses per revolution. This is the same as the 
number of teeth on the trigger wheel. Getting this number wrong will result in wrong 
results (even if RPM correct) 

12.3.1.2 Engine RPM 
In the RPM setup tab select this setting applied to RPM2 input function when using 
Engine RPM sensing clamp, see: YourDyno Instrument Installation manual. 
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Change the pulse count according to your ignition/engine type (typically 0.5 or 1). 

12.3.2  Gear ratio setup 

 
The Engine RPM control in YourDyno system is based on the Roller RPM signal from 
Hall-Sensor. There are many reasons why the actual Engine RPM (for example from 
OBD2 interface) cannot be used to correctly control the dynamometer. Mainly they are 
too slow. Since all roller dynamometers measure torque at wheels, it is important that 
the Gear ratio is correctly set. Otherwise, the Engine Torque reading will not be correct. 

In the Gear Ratio Setup tab you may choose between multiple ways of determining the 
actual current Gear ratio. 

12.3.2.1 Tacho 
Use this function if you have no other means of measuring or sensing the Engine RPM. 

This is the fastest but also least accurate way of determining the Gear ratio. 
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1. Select Tacho RPM setpoint. It is recommended to use middle of the Tachometer 

range somewhere that is easy to keep the engine revving at constant revs.  
2. Enter the vehicle and accelerate the car to reach the set RPM. 
3. Make sure you are on the gear you wish to use later for the test Run. Usually, it's 

4th or 5th gear. 
4. Try to hold the engine RPM at setpoint RPM value as precise as possible. 
5. When the RPM reading at vehicle tachometer is stabilized at setpoint value press 

"Lock gear ratio" button. 
The YourDyno Software now "knows" what is the total Gear ratio between engine and 
rollers. 

 
Please note that whenever you'll change gear the Gear ratio will be off and you need to 
repeat the procedure. 

12.3.2.2 RPM [Scan Tool] plugin 
Use this option when you have an OBD2 adapter in use and setup correctly. Please 
refer to Menu: Plugins -> Scan Tool (OBDII plugin) for details. 

Using OBD2 adapter is the most convenient and recommended way of determining 
Gear ratio. 

12.3.2.3 RPM [CAN Tool] plugin 
When using CAN bus adapter, the Engine RPM will be available to  

12.3.2.4 RPM2 input port. Engine RPM ignition clamp. 
Select this setting (activate via RPM setup tab - see above: Engine RPM) when using 
external Engine RPM ignition sensing clamp. 

Depending on the cylinder count, engine type, ignition type and location on the sensing 
clamp adjust the "Pulses per revolution" value in the RPM setup tab.: 
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12.3.2.5 Manual 
If you know the gear ratio, enter it in the manual mode. 

12.4  Drive modes 
12.4.1  Single axis dynamometer (2WD or motorcycle). Engine dynamometers 
In this Drive Mode only one axis is driven by the vehicle. It does not matter if the front 
or rear wheels are driven because only one axis is braked and only one vehicle axis is 
rolling with the dyno. 

 
This Drive Mode is applicable for all FWD or RWD cars, motorcycles and engine 
dynamometers. 
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In this use scenario the default settings are applicable without the need to change 
them at any time.: 

RPM 1 input function = Load Cell 1 RPM 
RPM 2 input function = Not used or Engine RPM 
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12.4.2  AWD dynamometer –RWD Mode - only rear wheels are spinning 

 
This applies to non-linked 4WD dynos 

In this Drive Mode only the rear is driven by the vehicle and the other axis is not 
moving.  

 

 

 

In this use scenario following settings are applicable (RWD): 

RPM 1 input function = Load Cell 1 RPM 
RPM 2 input function = Engine RPM or Not used 
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12.4.3  AWD dynamometer - FWD Mode - only front wheels are spinning 
In this Drive Mode only the front axis is driven by the vehicle. The rear axis spins freely 
and is not braked. Rear wheels of the car are NOT spinning. 

 
This Drive Mode is applicable for FWD-only cars. 
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In this use scenario following settings are applicable: 

RPM 1 input function = Engine RPM or Not used 
RPM 2 input function = Load Cell 2 RPM 

 

 

12.4.4  AWD dynamometer - AWD Mode 
In this Drive Mode both front and rear axis is driven by the vehicle. Both dynamometer 
axles are braked. All vehicle wheels are spinning with the rollers. 

 
This Drive Mode is applicable only for cars equipped with an AWD system. 
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In this use scenario following settings are applicable: 

RPM 1 input function = Load Cell 1 
RPM 2 input function = Load Cell 2 

 

 



YourDyno Instrument kit 
Software user manual 

YourDyno.com 
Fonneland Engineering AS, 2021 

 
12.5  Brake Control Setup. PID settings 
In this section you can setup the PID-Control for the brakes and set properties for 
different Brake Control / Test Modes. To open the Brake Control Setup please the 
"Brake setup" button in Run window: 

 

12.5.1  PID control 
To adjust the PID settings please navigate to "Control loop setup" tab in "Brake Control 
Setup" window. 
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12.5.1.1 Advanced PID settings 

 
Almost all types of brakes/retarders have non-linear brake characteristic. This 
advanced PID control is especially useful on engine dynamometers as it allows 
implementation of non-linear PID control strategies of the brake. 

To enable Advanced PID control please press the "Advanced" button. A new window 
will appear. In this window you can set "Multiplication factor" for specific RPM-range 
thus changing the actual PID parameters "on the fly".  

To use this feature please "Enable PID parameters scaling" checkbox. 

 

Example 

Setting "Multiplication factor" as follow: 
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will result in following PID parameters: 

in range from 0 to 4999 RPM 
Kp = 1 
Ki = 0.5 
Kd = 0.05 

and in range from 5000 RPM onward the PID parameters get scaled to: 
Kp = 0.5 
Ki = 0.25 
Kd = 0.025 

12.6  Test Modes 
12.6.1  Manual brake control. Manual RPM step test. 
In the "Manual brake control" mode the YourDyno Software will hold the set target 
engine RPM regardless of engine load (throttle opening). Adjust the RPM increment / 
decrements step using the corresponding field. 
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How well the YourDyno controller will hold the target RPM depends on the PID settings 
used. Adjust the PID parameters if needed. 

 

12.6.2  RPM Curve 
12.6.2.1 Overview 
In this test mode the YourDyno Software follows predefined Engine RPM target curve. 

You may add multiple RPM targets to create a test profile. 

Use mouse cursor to drag the RPM target points on the diagram. 
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Press "Edit ramp" button to open an RPM setpoint table and edit it manually. 

 
When editing the Time field use dot "." as decimal separator. When editing the RPM 
filed use only integer numbers. 
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Use "Load ramp" and "Save ramp" buttons to save and load RPM setpoint profiles from 
your hard drive. 

12.6.2.2 Using RPM Curve to test diesel engines. Loops in RPM graph 
Most diesel-powered cars will show significant torque at very low engine RPM. When 
testing such cars with standard Power Sweep with stabilization time it is not 
uncommon, that a characteristic "loop" will be visible in RPM-graph: 
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The reason for such graph shape is easy to explain. 

In this example the tested car/engine delivers peak torque at 1500 RPM. During 
standard Power Sweep at the beginning of the test the engine RPM will be stabilized at 
Starting RPM setting. This stabilization normally is done under WOT condition. In other 
words, the stabilization phase is nothing more than constant RPM at WOT where the 
inertia effect is marginal. As soon as the sweep starts the brake releases the engine to 
allow acceleration (lower blue line in graph below): 
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Allowing the car to accelerate introduces inertia effects - in other words power must be 
used to accelerate the rollers of the dynamometer and all rotating components of the 
car. 

 
See: Inertia compensation chapter for more information. 

As a result, the power and torque reading will drop because part of the kinetic energy / 
power is transferred to rotating system. It is then measured as "negative" 
power/torque during coasting and measurement of friction losses. Because the Power 
and Torque drop is also accompanied by Engine RPM drop this characteristic loop is 
generated. 

Avoiding such graph shape is possible when using RPM Curve instead of standard 
Power Sweep mode. Set the RPM Curve to desired Starting RPM and Sweep Rate, then 
postpone Logging of the Run to 2,2 seconds - in this example: 
Stabilization RPM at 1250 for 1,5 seconds 

Logging start at 2,2 second 
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Such settings will result will postpone the logging of the Run to actual Sweep bypassing 
the Engine RPM stabilization phase and generate clean graph: 

 
12.6.2.3 Automatic RPM Step test 
You can use the RPM Curve mode to perform semi-automatic RPM Step tests where 
the YourDyno Software will increase the Engine RPM target after specified time.  
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12.6.2.4 Double-Ramp test. Inertia compensation 
A Double-Ramp test is used to perform MOI compensation for unknown dynamometer. 

During this test the vehicle / dynamometer performs controlled acceleration and 
deceleration using same rate. As a result, an MOI (moment of inertia) compensation of 
the dynamometer + vehicle system can be performed. 

Please refer to this video for more information: 

https://www.youtube.com/watch?v=0RVmxpCk0SE 
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12.6.3  Power Sweep 
The Power Sweep Test Mode is the typical acceleration test performed to measure the 
Engine Power and Torque and draw the known "normal" dyno graph. In this Test Mode 
the acceleration rate (Sweep rate) defines how fast the Engine RPM will increase. 

In the "Start condition" section you can define the starting Engine RPM and wait time 
(preload time). The preload time is used to allow build-up of induction pressure in 
engines equipped with forced induction (super-charged / turbo-charged engines) 

In the "Define sweep" section select the desired Sweep rate in RPM per second and 
Stop RPM. 

 
Set the "Stop sweep at" RPM approximately 250-500 RPM below the vehicles RPM-
limiter. 
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12.6.4  Load Control 
This advanced Test Mode allows progressive Engine RPM control based on brake 
output gain and engine RPM gain speed factors. It is especially useful with Water 
Brakes or when the tested engine has very fast torque increase which can cause 
oscillations when using standard PID regulator. 

To use this mode set the "Start brake at" engine RPM target and "Start gain" brake 
output in %. 

Set the "Wait" time (preload time) before Sweep starts. 

Use the default "Regulate start RPM" setting, or use the Ramp up brake for non-
regulated startup.  

 

Adjust the sweep settings in "Define sweep" section. 
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The "Load Control" Test Mode will control the brake output according to selected 
"Gain" in % 

This means that the brake output will increase by specified % when the engine RPM 
increases by 1000 RPM. 

Under "Advanced" button you can change the "Gain factor" and "Sweep rate factor" 
multiplications - similarly as in "Advanced PID settings" 

 

12.6.5  Brake sweep 
This test mode was designed especially for hydraulic brakes. In this Test Mode the 
brake output is gradually increased or decreased without the use of PID control. This 
means that the target sweep rate and actual engine RPM may vary as the Brake Sweep 
mode will not try to stabilize the engine RPM - instead it will only gradually increase 
brake output from the "Start brake" value. 
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The benefit of this Test Mode is that because no PID control is in use the system will 
not generate any oscillations. 

 

Note that most hydraulic dynos work best from high to low RPM. To enable this, set the 
Target sweep rate to a negative number, for example -500 RPM per second. 

12.7  Auto start stop 
12.7.1  Automatic recording of test Run 
This function allows automatic recording of test Run. Use the corresponding tab in 
"Brake setup" window to adjust the "(Re)Start run at RPM:" value. 

 
When Retardation data (Friction losses) measurement is ON the recording of the test 
Run will stop only after the engine RPM has dropped back to Starting RPM value. 
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12.8  Brake control update frequency 
The brake can be controlled (adjusted) up to 20 times per second. Higher frequency = 
tighter control but more CPU intensive.  

12.9  Ramp brake up 

 
It is recommended to use ramp the brake up as it reaches the start RPM. This will 
ensure a lower overshoot since the brake that is already engaged. When the brake % is 
set roughly right, you don’t need any stabilization period before the sweep and data 
recording start.  



YourDyno Instrument kit 
Software user manual 

YourDyno.com 
Fonneland Engineering AS, 2021 

 

 

12.10 Use brake to slow down rotation after run 

 
Using the brake to slow down the dynamometer after a run in is complete will have 
effect only when recording is complete. When measuring Retardation data, the brake 
will only turn on after the retardation recording is complete.  

To enable this feature please set the desired Brake output in % in the "Control loop 
setup" tab in the "Brake setup" window. 
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12.11 Automatic MOI test 
The automatic MOI (moment of inertia) test is used to determine the complete system 
inertia (dynamometer + vehicle). 
The MOI setting is base for all result evaluation thus it is recommended for all users to 
perform the automatic MOI test for all vehicles prior to actual power test. This test is 
performed using two coast-down phases: first un-braked and second braked. From the 
difference in de-acceleration of the vehicle between these two tests the software will 
calculate the system MOI. 

Please note that this calculated MOI takes following losses into account: 

 friction losses in drive-train 
 friction losses between roller and tire 
 friction losses in dynamometer 
As with any other roller-dynamometer there are still some losses which cannot be 
measured during such procedure (for example hysteresis of elastic components and 
power losses in drivetrain). 

12.11.1 Automatic MOI test procedure 
1. Start a "New Run + Record new retardation data". 
2. Setup "Power Sweep" mode as you would do normally. Make sure that the "Stop 

sweep at" RPM is set below actual RPM limiter in vehicle. Setup sweep rate at 500 
RPM/s. It is important that recorded test will end with the "Coasting" state at the 
end of the test run. 

3. In the Run window please open the "MOI setup" wizard and press "Start MOI 
measurement wizard". 
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4. After pressing the start button the Wizard will ask you to perform two test runs. It is not 
necessary to perform these tests under WOT conditions. However, you must reach the "Stop 
sweep at" RPM such that the status change from "Logging" to "Coasting". Alternatively, 
press the manual Coasting button.  

5. At the end of second test the wizard will show you determined MOI value. You can now 
decide if you want to use this value for actual power measurements. 

 

 
It is recommended to use the Manual Coasting button (space bar) to ensure that the 
dyno goes into coasting mode exactly at the same time as the clutch is pushed in.  

12.11.1.1 Advanced options 
Since the automatic MOI test takes place during coast down phase (clutch pressed or 
automatic gearbox in N) you can use the Advanced Settings to include Engine Inertia in 
the calculation. 

If you are not sure what value to use, please leave the default setting. 
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Should the second coast down phase be too rapid or too slow please adjust the 
retarder output accordingly. 

 

In case your dyno has substantial inertia (recommended is over 50 kgm²) you can use 
the single retardation run test. In this test version only one coast-down phase is 
needed to measure MOI - the first part of the coast-down phase is not braked while the 
second is. 

 

 


